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1.	 Description
This product is for research use only.

1.1	 Background information

MACSPlex Assays have been designed for determining 
concentrations of soluble cytokines in a single sample. The analysis 
is based on MACSPlex Capture Beads, which display defined 
fluorescence properties and can be identified using standard flow 
cytometry techniques. 
In combination with the Express Modes of specific MACSQuant 
Instruments the MACSPlex Cytokine Kits are optimized for 
automated measurement. They simplify flow cytometric analysis 
via predefined instrument and experiment settings as well as 
acquisition and analysis templates. They apply an automated 
gating strategy to populations of interest that will be automatically 
adjusted for each data file to achieve optimal results. They 

also provide the possibility to manually correct the analyte 
identification for analysis if necessary.
The Express Modes MACSPlex_Standard and MACSPlex_ 
Sample have been developed for use with the MACSPlex Cytokine 
Kits. The measurement and analysis using these Express Modes 
can be performed with the MACSQuant Analyzer 10 and the 
MACSQuant X. 
MACSPlex_Standard is used for the measurement of the 
MACSPlex Cytokine Standard. It contains all relevant information 
for the determination of the standard values based on the serial 
dilution of the MACSPlex Cytokine Standard. If replicates of the 
serial dilution of the standard are measured, mean values of the 
replicates will be calculated. 
MACSPlex_Sample is used for the measurement of samples 
containing unknown cytokine amounts. To accurately calculate 
the cytokine concentrations in an unknown sample both Express 
Modes, MACSPlex_Standard and MACSPlex_Sample, have to be 
used. The cytokine concentrations of unknown samples will be 
determined based on the last acquired MACSPlex_Standard values.

1.2	 Reagent and instrument requirements

●	 MACSQuant Analyzer 10 (# 130‑096‑343) or MACSQuant X 
(# 130-105-100) with MACSQuantify Software version 
2.13.1 (or higher) and the MACSPlex Express Mode package 
213.2.20284 (or higher).

 ▲ Note: The MACSQuant VYB cannot be used.

●	 Chill 96 Rack (# 130-094-459)

●	 MACSQuant Calibration Beads (# 130-093-607)

●	 MACSPlex Cytokine Kit, for example, MACSPlex Cytokine 12 
Kit, human (# 130-099-169), MACSPlex Cytokine 10 Kit, mouse 
(# 130-101-740), MACSPlex Cytokine Reagent Kits, human or 
mouse, or MACSPlex Cytotoxic T/NK Cell Kit, human (# 130-
125-800) 

 ▲ Note: Do not mix human and mouse in one experiment.

1.3	 Estimation of time and buffer for data acquisition using the 
MACSQuant Instrument

Estimation for acquisition with default settings of Express Modes 
on MACSQuant Analyzer 10 (150 μL sample uptake with high flow 
rate and Standard Mode with active mixing):

 MACSQuant Running Buffer Time

1 sample 20 mL 2.5 minutes

96 samples 2000 mL 4 hours

Data acquisition and analysis 
of the MACSPlex Cytokine Kits 
using the MACSQuant® Analyzer 
Express Modes in MACSQuantify™ 
Software version 2.13.1
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2.	 Data acquisition using the MACSQuant 
Analyzer 10 or MACSQuant X Express Modes

▲ Use the autolabel function including the 2D code reader of the 
MACSQuant Instrument to ensure the selection of the correct 
reagent lot and to upload all necessary MACSPlex information. 
These include population data, name of analyzed cytokines, median 
for B1, median for B2, the maximum number of standard positions 
within the serial dilution, dilution factors, and concentrations 
of each cytokine in the MACSPlex Cytokine Standard. When 
using the MACSPlex Cytotoxic Cytokine Kits all labeling steps 
are performed manually. The autolabel function is only used to 
identify reagents, to add required information to data files, and to 
load the predefined experiment for acquisition. 

▲ For further information refer to the MACSQuant® Instrument 
user manual and the MACSQuantify™ Software user guide.

Perform login to software and verify software version

Select sample rack – MACSPlex Filter Plate (optionally: Chill 96 Rack)

Select and assign MACSPlex Capture Beads using the 2D code reader and NoLabel in the 
Autolabel tab 

Assign positions of serial dilutions of MACSPlex Cytotoxic T/NK Cell Standard:
• Group positions
• Select Express Mode MACSPlex_Standard
• Choose appropriate mixing, e.g., Mix gentle
• (Optional) Define new sample IDs and description
• (Optional) Change predefined experiment settings

Assign positions of unknown samples:
• Define positions of unknown samples
• (Optional) Group positions
• Select Express Mode MACSPlex_Sample
• Choose appropriate mixing, e.g., Mix gentle
• (Optional) Define sample IDs and description
• (Optional) Change predefined experiment settings

Verify correct rack definitions in the Experiment table 

Ensure correct liquid levels in MACSPlex Filter Plate wells 

Start measurement

Figure 2.1: Overview of data acquisition with a manually defined 
experiment.

For a correct MACSPlex Filter Plate calibration please contact your 
administrator or refer to chapter “Calibration of the MACSPlex 
Filter Plate” of the MACSQuant® Instrument user manual.

Perform login to software and verify software version

Upload predefined experiment by scanning the 2D code on the vial of the  
MACSPlex Capture Beads

(Optional) Adjustment of predefined experiment setting:
• Deletion of unused positions
• Ungroup MACSPlex_Sample positions
• Assignment of sample ID and description

Verify correct rack definitions in the Experiment table 

Ensure correct liquid levels in MACSPlex Filter Plate wells 

Start measurement

Figure 2.2: Overview of data acquisition with with predefined experiment 
settings.

For a correct MACSPlex Filter Plate calibration please contact the 
administrator or refer to chapter “Calibration of the MACSPlex 
Filter Plate” of the MACSQuant Instrument user manual.

2.1	 Login
Login as a custom mode user. Make sure the instrument is in 
acquisition mode, i.e., bottles are illuminated and the instrument 
status bar displays Acquisition mode. 
For optimal results it is important to perform a PMT calibration of 
the instrument prior to use. 
For a proper Express Mode acquisition and analysis performance 
please avoid special characters or annotations (e.g. “ö”, “ë”, “oe”, 

“μ”, etc.) for the data file name structure.

2.2	 Verify software version 
1.	 Select Help > Info… from the menu bar.

2.	 Verify that the MACSQuantify Software version 2.13.1 
or higher (refer to figure 2.3) and the MACSPlex Express 
Mode package 213.2.20284 or higher are installed on the 
MACSQuant Instrument.

Figure 2.3: Information window for MACSQuantify Software.

2.3	 Instrument settings
The instrument settings are automatically uploaded when using the 
MACSPlex Express Modes with MACSQuantify Software version 
2.13.1 or higher after assigning the MACSPlex Capture Beads. The 
loading of the settings will be performed when the measurement 
starts. 

2.4	 Use predefined experiment settings or perform manual 
experiment definition 

There are two options to set up the experiment. For the MACSPlex 
Cytokine 12 Kit, human, and MACSPlex Cytokine 10 Kit, mouse, 
predefined experiment settings are available in the software (please 
refer to chapter 2.4.1 and figure 2.2). For the other MACSPlex 
Cytokine kits and also for the individual combination of analytes 
(MACSPlex Custom or MACSPlex Mix) no predefined experiment 
settings are provided in the software. Here, the experiment settings 
have to be defined manually as described in chapter 2.4.2 and 
figure 2.1.

2.4.1 Use predefined experiment settings
2.4.1.1 Upload predefined experiment settings
In order to use the Express Mode, reagent information of the 
MACSPlex Kit needs to be identified. This is achieved by using 
the autolabel function and the 2D code reader of the MACSQuant 
Instrument. With the MACSQuantify Software version 2.13.1 
a predefined experiment can be uploaded for the MACSPlex 
Cytokine 12 Kit, human, or for the MACSPlex Cytokine 10 Kit, 
mouse, by using the 2D barcode of the MACSPlex Capture Beads 
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vial, containing all relevant settings for the acquisition. 
If the reagent label on the vial is damaged or the scanning of the 
barcodes is not successful, the predefined experiment can be 
selected manually as described in chapter 5.2. 
When working with the MACSPlex Custom Cytokine Assays 
or other MACSPlex Cytokine Kits than mentioned above no 
predefined experiment settings are provided. For the manual 
creation of a MACSPlex Cytokine experiment, please proceed with 
chapter 2.4.2.

1.	 Click on the Barcode button of the toolbar and wait for the 2D 
code reader to start blinking. Present the vial containing the 
MACSPlex Capture Beads to the 2D code reader. Ensure the 
2D code is facing the blinking code reader light in the optimal 
reading distance of 0.5–2.5 cm.

 ▲ Note: The predefined experiment is based on the MACSPlex Filter Plate. It 
contains the MACSPlex_Standard positions (duplicate of serial dilution) with 
vertical rack processing order in column 1 and 2. Columns 3–12 are grouped 
and assigned to MACSPlex_Sample position. For the whole plate the autolabel 
for the appropriate MACSPlex Capture Beads and for NoLabel are selected and 
assigned. If the positions of the serial standard dilution on the plate are not 
positioned in column 1 and 2, please proceed with chapter 2.4.2. 

2.4.1.2 (Optional) Adjustment of predefined experiment settings
▲ If not complying with the predefined experiment in terms of,  
e. g., sample volume or order of serial dilution of standards, please 
refer to chapter 2.4.2.3 or chapter 2.4.2.4.

2.4.1.3 Deletion of unused MACSPlex_Sample Positions
▲ Always delete unused positions in the predefined experiment 
settings. 

▲ Grouping can be performed on several columns as long as the 
rack positions are adjacent. 

▲ If the middle positions of a grouping are deleted the group will be 
splitted into two (indicated by two different numbers on the wells). 

▲ If sample positions are not adjacent, the measurement can be 
performed without grouping positions. Then the grouping of 
sample positions needs to be performed during data analysis to 
enable batch analysis on all samples at once.

1.	 To delete unused sample positions click on the relevant well 
or column. A closed green circle with an orange rim indicates 
sample position activation. 

2.	 Click Clear to delete the activated positions. 

3.	 (Optional) To ungroup the MACSPlex_Sample positions 
double-click on one well to activate all positions within the 
group (indicated by orange rim). Click Ungroup to ungroup 
the positions. 

2.4.1.4 Assignment of Sample ID and Description 
Additional user-defined information can be entered in the 
Experiment tab, fields Sample ID and Description. Sample ID 
and Description can be allocated individually to each sample 
position. Please avoid special characters or annotations (e.g. “ö”, 

“ë”, “oe”, “μ”, etc.).

2.4.1.5 Further proceeding
Proceed with step 2.5.

2.4.2 Manual experiment definition
2.4.2.1 Select the sample rack

1.	 In the sidebar Experiment tab, select the MACSPlex Filter 
Plate from the Rack drop-down list. When not using a 
MACSPlex Filter Plate select Chill 96 rack.

 ▲ Note: If the plate is not displayed in the window, activate the Rack icon of 
the toolbar.

Figure 2.4: Selection of the rack type.

2.4.2.2 Select and assign MACSPlex Reagents 

In order to use the Express Mode, reagent information of the 
MACSPlex Cytokine Kit need to be identified by using the autolabel 
function and the 2D code reader of the MACSQuant® Instrument. 

If the reagent labels on the vials are damaged or scanning of the 
barcodes is not successful, the reagents can be manually selected 
(please refer to chapter 5.1). 

When using MACSPlex Custom Cytokine reagents (also MACSPlex 
Mix) do not exceed the maximum number of seven analytes and 
do not mix human and mouse reagents in the same experiment. Do 
not mix different MACSPlex Mix categories. 

1.	 Click on the Barcode button of the toolbar and wait for the 
2D code reader to start blinking. Present the vial containing 
the MACSPlex Capture Beads to the 2D code reader. Ensure 
the 2D code is facing the blinking code reader light in the 
optimal reading distance of 0.5–2.5 cm. Once scanned 
a MACSQuantify™ Software dialog box will appear with 
information about where to place the reagent on the reagent 
rack as long as no predefined experiment exists. 

	 When using the MACSPlex Custom Cytokine reagents, repeat 
step 1 for each MACSPlex Capture Beads.

 ▲ Note: If a predefined experiment setting exists, the experiment will be 
uploaded and displayed instead of the dialog box (refer to chapter 2.4.1). If you 
need the rack “MACSPlex Filter Plate” for your manually defined experiment, 
select all positions on the rack, and clear them. If you need another rack type, 
select the appropriate rack accordingly and proceed with step 2 to check the 
reagents (refer to figure 2.5 and 2.6).

2.	 The scanned reagent and a NoLabel check box will 
automatically be displayed in the Autolabel tab of the 
Experiment tab.

3.	 Check the respective MACSPlex Cytokine Capture Beads and 
NoLabel boxes in the Autolabel tab located in the Experiment 
tab. The red exclamation mark indicates the activated autolabel 
function. 

 ▲ Note: It is important to tick NoLabel option. It will disable pipetting steps, 
which are usually performed by the MACSQuant Instrument during an 
autolabeling procedure. 
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Figure 2.5: Tick MACSPlex Capture Beads and NoLabel boxes in 
the Autolabel tab (example given for MACSPlex Cytotoxic T/NK Cell 
Capture Beads).

Figure 2.6: Tick MACSPlex Capture Beads and NoLabel boxes in the 
Autolabel tab (example given for MACSPlex Custom Cytokines with 
seven analytes).

2.4.2.3 Assignment of MACSPlex_Standard positions

▲ The first column(s) of your experiment on the plate have to 
contain the MACSPlex Cytokine Standards. Refer to the kit data 
sheet for more information.

▲ Due to the Express Mode calculation processes the wells of the 
serial dilution have to be grouped so that one data file is created for 
the measurement of all wells. 

▲ Due to the grouping the definition of standard positions and the 
selection of the Express Mode must be performed individually for 
each serial dilution.

▲ For standard dilution replicates, make sure that the same 
number of wells is selected and arranged in the same sequential 
order. In case of not complying with the kit protocol (refer to the 
kit data sheet) regarding final sample volume or order of serial 
dilution of standard, please refer to “(Optional) Change predefined 
experiment settings” below.

Define positions for serial dilutions of the cytokine standards
▲ Repeat steps for each of the two serial dilution individually.

1.	 Define the positions for the samples of one serial dilution of 
the cytokine standards by selecting the respective wells in 
the Rack window. Do not exceed the maximum number of 
standard positions allowed for the used kit as indicated in the 
kit data sheet.

2.	 Group these positions by using the Group feature. Grouped 
positions will be assigned with the same group number.

Figure 2.7: Select well positions for the samples of one serial dilution 
and use the Group button. Grouped well positions of each serial dilution 
of the MACSPlex Cytokine Standard will be assigned the same group 
number (example given for a kit with 8 standard positions allowed).

Select the Express Mode for measurement of the MACSPlex 
Cytokine Standards  
Repeat steps for each serial dilution individually.

1.	 Select the Settings tab. 

2.	 Check the Express button. 

3.	 Select Analysis from the Type drop-down list. 

4.	 Choose MACSPlex_Standard from the Mode drop-down list 
(refer to figure 2.8).

5.	 A warn window appears in terms of sample mixing (refer to 
figure 2.9). Choose an appropriate mixing program from the 
Mix sample drop-down list (refer to figure 2.10). 

By selecting the Express Mode all experiment settings are 
automatically loaded. The loaded values are shown in the respective 
fields in the Experiment tab. 

Figure 2.8: Selection of MACSPlex_Standard from the Settings tab.

Figure 2.9: Warn window in terms of sample mixing.

Figure 2.10: Selection of Mix gentle from the Mix sample drop-down list.
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(Optional) Defining new sample IDs and a description for the 
serial dilution of the MACSPlex Cytokine Standard 

The sample IDs are automatically applied to the well positions 
according to the predefined order as displayed in the Sample ID 
drop-down list. However, if the samples of the dilution series are 
not added to the plate in the predefined order, sample IDs have to 
be changed manually by choosing the respective value from the 
Sample ID drop-down list. For the correct assignment of the serial 
dilution to the Sample IDs refer to the kit data sheet. Make sure 
that no double assignments have been done. 
Additional user-defined information can be entered in the field 
Description. Please note that only one description may be assigned 
per group of standards (all positions of the group have to be 
selected). Avoid special characters or annotations (e.g. “ö”, “ë”, “oe”, 

“μ”, etc.) in the Description field.

Figure 2.11: The sample IDs for the MACSPlex_Standard can be 
manually changed in the Sample ID drop-down list.

(Optional) Change predefined experiment settings 
Logging in as a custom mode user allows to change the default 
experiment settings defined by the Express Mode. This might be 
necessary if the protocol was not exactly followed, e.g., if the final 
sample volume per well in the MACSPlex Filter Plate has been 
changed from the recommendations given in the kit data sheet. 

 ▲ Note: Changes to the Express Mode settings can affect the automated calculations 
during the analysis. For example, if the uptake volume has been reduced, there may 
not be enough events in the data file for an accurate analysis. 

2.4.2.4 Assignment of MACSPlex_Sample positions 

Define and group positions for unknown samples 

1.	 To define positions click on the wells that contain the unknown 
samples. A closed green circle with an orange rim indicates 
sample position activation.

2.	 Group these positions by using the Group button. Group only 
rack positions that are adjacent and in columns.

 ▲ Note: Grouping can be performed on several columns as long as the rack 
positions are adjacent. If sample positions are not adjacent, measure without 
grouping and perform grouping of unknown samples during data analysis to 
enable batch analysis on all samples of your experiment at once.

Select the Express Mode for MACSPlex Samples 

1.	 Make sure all relevant sample positions are selected, i.e., 
highlighted with an orange circle. A group can be selected by 
double-clicking on one of its positions.

2.	 Select the Settings tab. 

3.	 Click on the Express button. 

4.	 Select Analysis from the Type drop-down list. 

5.	 Choose MACSPlex_Sample from the Mode drop-down list 
(refer to figure 2.8).

6.	 A warn window appears in terms of sample mixing (refer to 
figure 2.9). Choose an appropriate mixing program from the 
Mix sample drop-down list (refer to figure 2.10). 

By the selection of the Express Mode all experiment settings except 
the Mix sample parameter are loaded automatically. The loaded 
values are shown in the respective fields of the Experiment tab. 

(Optional) Defining new sample IDs and a description for 
unknown samples 
Use the Sample ID and Description fields to enter relevant sample 
information. For detailed information, please refer to chapter 
2.4.2.3. 
Sample ID and Description can be allocated individually to each 
sample position within the group.
Avoid special characters (e. g., “ö”, ”ë”, “œ”, or “µ” etc.) in the data 
file names, Sample ID, and Description.

(Optional) Change predefined experiment settings
Logging in as a custom mode user allows you to change the default 
experiment settings defined by the Express Mode. This might be 
necessary if the protocol was not exactly followed, e.g., if the final 
sample volume per well in the MACSPlex Filter Plate has been 
changed from the recommendations given in the kit data sheet. 

 ▲ Note: Changes to the Express Mode settings can affect the automated calculations 
during the analysis. For example, if the uptake volume has been reduced, there may 
not be enough events in the data file for an accurate analysis. 

2.4.2.5 Further proceeding
Proceed with step 2.5.

2.5	 Check the rack definitions

Before starting the measurement, especially if the predefined 
experiment has been adjusted, it is recommended to check and 
verify the rack definitions using the Experiment table:

1.	 Select View > Experiment table… from the main menu.

2.	 Ensure that rack definitions for Acquisition, Annotations, 
Autolabel, and Settings are correct.

3.	 If the assignment of the MACSPlex_Standard positions has 
been changed, check in the Acquisition tab that no double 
assignments of Sample IDs within one serial dilution of 
MACSPlex Cytokine Standards have been done.

4.	 Check the Autolabel and Settings tabs and make sure that 
for each selected position the correct MACSPlex Cytokine 
Capture Beads, NoLabel function, as well as the correct 
Express Mode are selected.
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Figure 2.12: Control of rack definitions in the Autolabel tab of the 
Experiment table (example given for MACSPlex Cytotoxic T/NK 
Cell Kit, human).

Figure 2.13: Control of rack definitions in the Settings tab of the 
Experiment table.

2.6	 Control wells for liquid level 

1.	 Place the MACSPlex Filter Plate on a Chill 96 Rack. Make sure 
that all residual drops under the plate are completely removed 
to prevent liquid carry over (refer also to the kit data sheet). 

2.	 Ensure that all used wells of the MACSPlex Filter Plate contain 
the required amount of liquid, as described in the kit data 
sheet. In case of leaks remove any residual drops from under 
the plate completely, e.g., by placing the plate briefly onto a 
tissue. If required, fill up wells with the relevant amount of 
buffer. 

2.7	 Start the measurement 

▲ Before starting the measurement, ensure buffer supply and an 
empty waste bottle of the MACSQuant® Instrument are sufficient 
(refer to section 1.3). 

▲ If measuring a whole plate, use the orange protective cover to 
avoid optical whitening of APC staining.

1.	 Click Start measurement. 

2.	 The acquisition window, defined by the selected Express Mode, 
will appear on the screen. After completion of the acquisition 
the Express Mode will automatically proceed to the analysis 
(for grouped positions, the analysis starts after measurement 
of the last position within the group). All relevant information 
(acquisition window, analysis window, type of Express Mode, 
instrument settings) are saved within the data file and do not 
have to be saved separately. 

 ▲ Note: The time difference between the first MACSPlex_Standard 
measurement and the first MACSPlex_Sample measurement should not 
exceed two hours to ensure the assignment of the appropriate standard data 
to the respective sample analysis. Moreover, when performing more than one 
assay within two hours, do not reactivate former MACSPlex_Standard data 
files before or during a measurement to avoid the assignment of inappropriate 
former MACSPlex_Standard data files to the current sample analysis. Always 
monitor until the measurement has been started in case of warn windows 
appear. 

3.	 Analysis of data files with the MACSPlex Express 
Modes

The analysis of the data files can be performed on the MACSQuant 
Instrument itself or on a PC with installed MACSQuantify™ 
Software version 2.13.1 (or higher) with the MACSPlex Express 
Mode package 213.2.20284 (or higher). 

 ▲ Note: When the analysis of data files is performed on the MACSQuant Instrument, 
not all analysis functions are available. The functions of manual correction of analyte 
identification, the change of standard values, and the automatic export of results 
cannot be used.

▲ Important! The MACSQuantify Software version and the 
Express Mode version must be the same on the MACSQuantify 
Software PC version as of the used MACSQuant Instrument.  

▲ After finishing the measurement, do not perform the  
MACSPlex_Standard analysis on the MACSQuant Instrument if 
another MACSPlex Cytokine Assay is going to be measured within 
the next two hours.

3.1 Analysis of data files using the Express Modes

1.	 When performing the data analysis on a PC, make sure that 
the MACSQuantify Software is set to the correct instrument 
configuration: Select Edit > Configuration... from the main 
menu to select the MACSQuant Instrument that was used for 
data acquisition.

2.	 Right-click within the Samples tab and select Add… or 
Open... from the context menu to upload data files to the 
MACSQuantify Software.

 ▲ Note: If MACSPlex_Sample positions were acquired ungrouped, group the 
appropriate data files to enable batch analysis. Mark the data files in the sample 
list, right-click on the marked files, and select Group. Assure that only samples 
from the same experiment are grouped. Do not mix them with MACSPlex_
Standard files. The order of the grouped samples in the grouped file (marked 
by “_”) is based on the order of the files in the sample list (from top to bottom). 

3.	 Right-click on the file name and select 
View  with  Analysis.<name of the Express Mode> (i. e., 
MACSPlex_Standard or MACSPlex_Sample) for accessing 
the Express Mode analysis.

 ▲ Note: The analysis of the grouped data file can take a certain amount of time 
due to the high number of events in the grouped file.

 ▲ Note: Perform analysis always by using View with…. If using the Analysis 
Mode tool to scroll through samples in list, the calculation of the cytokine 
concentration results is not applied to the correct sample.
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Figure 3.1: Selecting the Express Mode for analysis of the data files.

4.	 A control page is displayed in combination with the gate 
verification window (refer to figure 3.2) to allow a manual 
correction of the regions for the analyte identification. The 
gate verification window can be moved on the screen and 
allows access to the plots. Check if the analytes are assigned 
correctly to the bead populations (please compare with kit 
data sheet). 

	 The forward scatter area (FSC-A) versus side scatter area (SSC-
A) density plot allows the identification of the singlet beads 
and the B1-A (FITC) versus B2-A (PE) density plot for the 
identification of the different color-coded bead populations, 
which identify the analytes.

	 When all gates are set correctly and all analytes are assigned 
correctly by the Express Mode, close the gate verification 
window by clicking the “x”.

	 If gates are not set correctly or if analytes are not assigned 
correctly, correct the regions manually. When done, close the 
gate verification window with the Gating adjusted button.

	 The appropriate MACSPlex analysis page(s) will be displayed 
after analysis has been finished. 

 ▲ Note: When analytes cannot be assigned at all, placeholder regions for the 
affected analytes are positioned in the upper left corner of the plot. This is done 
on the PC, but also on the MACSQuant® Instrument.

 ▲ Note: How the gate verification window is closed influences the finally 
displayed text in the information on the control page (refer to figures 3.4 and 
3.5).

 ▲ Note: Only gate modification that is performed while the gate verification 
window is displayed, influences the Express Mode analysis and the Express 
Mode statistics. Gate modification that is performed after the Express Mode 
analysis is finished, does not influence the results.

Figure 3.2: Gate verification window.

Figure 3.3: Control page for correction of analyte assignment 
(example given for Express Mode MACSPlex_Standard).

Figure 3.4: Information text on control page, when gate 
modification window is closed with “x” and no manual gate 
modification was performed.

Figure 3.5: Information text on control page, when gate 
modification window is closed with “Gating adjusted” and gates 
were adjusted manually.

	 The control page is part of the analysis of both Express 
Modes, MACSPlex_Standard and MACSPlex_Sample, and 
displayed as the first page in each case. In addition to that, for 
MACSPlex_Standard data files the data will be displayed in a 
single analysis window without further user interaction. 

	 For the MACSPlex_Sample data during analysis, standard 
values or changed standard values can be chosen. For 
further details, please refer to chapter 3.3. At the end of the 
analysis an information window is displayed which shows the 
automatically exported results and their directory before the 
final analysis pages are displayed. By clicking OK in the info 
window, the display of the analysis pages will be finalized.
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Figure 3.6: Information window about exported results.

 ▲ Note: The options to manually correct the analyte identification, to change 
standard values, and the automatic export of results are only performed in 
the software installed on an accessory computer and not on the MACSQuant 
Instrument itself. Also the control page is not displayed on the MACSQuant 
Instrument.

 ▲ Note: When a manual correction of the analyte identification is done on 
the MACSPlex_Standard data file(s), the MACSPlex_Sample analysis has to 
be done with the changed standard values to use the corrected values for the 
analysis (please refer to chapter 3.3).

 ▲ 	Note: When the manual correction of the analyte identification is done on 
a grouped data file, the correction is automatically applied to all samples in the 
groupd data file.

5.	 The plot windows of the MACSPlex_Standard and MACSPlex_
Sample analysis display all relevant information, including the 
trend of the APC median of each standard concentration in 
the MACSPlex Standard samples. Also final concentrations of 
each cytokine are shown.

The major plot of the MACSPlex_Standard analysis window shows 
the increase of the APC median values for increasing standard 
concentrations for the MACSPlex Cytokine Kit (figure 3.7). The 
MACSPlex_Sample analysis window shows a diagram with the 
logarithmic overview of the determined cytokine concentration of 
all cytokines in the unknown sample (figure 3.8).

Figure 3.7: MACSPlex_Standard analysis window, displaying all 
relevant information. HDR-G abbreviates the group parameter in the 
MACSQuantify Software. In case of MACSPlex Assays, each position of 
HDR-G represents a measured standard cytokine concentration.

Figure 3.8: MACSPlex_Sample analysis window from the MACSPlex 
Cytokine 12 Kit. The statistics table displays the Express Mode name and 
version number, the kit name, the date of the measurement, the file name, 
the rack position of the sample, the sample ID, and the description of the 
data file and lists the final concentration of each cytokine measured in the 
unknown sample. 

The automatic export contains a table with the sample identifying 
parameters well ID, sample ID, and description and the 
corresponding cytokine concentrations, R1 (APC) medians, or 
counts, respectively, for each analysis.

Figure 3.9: Example from automatically exported concentrations of 
unknown samples.

If the unknown samples have been pre-diluted, the dilution factor 
will not automatically be included in the cytokine concentration 
calculated by the software. These have to be calculated by the user. 

If standard curve raw data are needed, including the APC medians 
for each concentration level of each MACSPlex population, 
they can be viewed in the csv-file created by the Express Mode 
MACSPlex_Standard. For more information on the export of csv 
files, please refer to the MACSQuantify™ Software user guide or 
contact Miltenyi Biotec Technical Support. 

3.2 Additional information about analyses 

During the acquisition of the unknown samples, the MACSPlex_
Sample Express Mode utilizes the average APC medians from the 
MACSPlex_Standard measurements and saves this information as 
an extension of the data file. Based on this extension it calculates 
the cytokine concentration levels. 

The regions for the singlet gate and for the color-coded bead 
populations are determined on the whole amount of events of the 
grouped data file. Afterwards the regions are linked to each sample 
position of the grouped file. Therefore the same regions are applied 
to all samples of the batch analysis. 

The names of the regions are not automatically displayed in the 
analysis template (but on the control page). Click the i button 
next to the dot plot and select the Region functions tab. Select the 
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functions Name or Path and confirm it by selecting OK or Apply 
to display the names of the regions. 

The calculation of the cytokine concentration in the unknown 
samples is based on a combination of monotone cubic Hermite 
interpolation and linear interpolation. 

During the analysis of the cytokine standard curves the range 
of monotonic increasing behavior is identified and sets the 
concentration range for the calculation (light grey area in figure 
3.10). The upper and lower detection limits describe the APC 
median values that border the well-defined concentration-
median assignment (dark grey area in figure 3.10). The calculation 
only takes place within the concentration range of monotonic 
increasing behavior. As shown as an example in figure 3.11, sample 
APC median values that are above the 2,000 pg/mL APC median 
value are marked with “> 2000.0 ! pg/mL”.

Figure 3.10: Demonstration of the different defined calculation areas 
within an exaggerated cytokine standard curve.

Figure 3.11: Example of a MACSPlex_Sample statistic with special 
marked results.

Special markings of cytokine concentration results: 
“!”: APC median values used for calculation of sample concentration 
are outside the defined median range and could correlate to more 
than one concentration of the standard curve. The value assigned 
is the one within the concentrations range of monotonic increasing 
behavior of the APC median (light grey area of figure 3.10). 

“<…!”: APC median values used for calculation of sample 
concentration are below the lowest APC median value of 
the standard curve. The corresponding standard cytokine 
concentration is displayed. 

“>…!”: APC median values used for calculation of sample 
concentration are above the highest APC median value of 
the standard curve. The corresponding standard cytokine 
concentration is displayed. 

“No result !”: Calculation of the cytokine concentration for the 
relevant analysis was not possible as the standard APC median 
values do not show a proper increasing behavior. Other analysis 
within the experiment may also not have the expected behavior 
due to premixed cytokine standards.

All results that are calculated outside the well-defined range are 
also marked red.

The complete analysis of standard and sample data files is a self 
contained system. Later manual modifications of the gates, which 
are not done while the gate verification window is active in the 
analysis, do not have any effect on the calculated results. In case of 
manual intervention in the gating the final cytokine concentration 
of the unknown samples has to be determined manually.

3.3	 Analysis of MACSPlex_Sample data files with changed 
standard values

The MACSPlex Cytokine Express Modes in the MACSQuantify™ 
Software have the option to perform the MACSPlex_Sample 
data file analysis based on changed standard values. This can 
be necessary if a MACSPlex_Standard data file analysis shows 
unexpected behavior. Therefore, please check the analysis of 
the MACSPlex_Standard data before processing the analysis of 
MACSPlex_Sample data. 

The possibility to change standard values can only be performed on 
the PC not on the MACSQuant Instrument. 

 ▲ Note: Assure not to upload empty csv files. If more than one csv file containing the 
average cytokine standard values has been uploaded they all have to have the same 
analytes and standard cytokine concentration levels.

During MACSPlex_Sample data analysis a question window is 
displayed to choose between standard values or to change standard 
values.

Figure 3.12: Question window if standard values are ok or not.

If the standard values of the experiment are ok, click Continue 
and the analysis proceeds with its general behavior based on the 
standard values of the experiment and the information window 
about the exported results is displayed (refer to figure 3.6).

If the standard values of the experiment are not ok, click Modified 
to proceed with changed standard values. 
A question window is then displayed, asking how many sets of 
standard values are going to be uploaded. Select the number by 
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clicking on the up and down arrow buttons and click OK. A set 
of standard values is represented by the analyzed values of one 
MACSPlex_Standard data file. For each data file, these values are 
saved within a csv file. 

 ▲ Note: This question window cannot be closed by clicking the X button.

 
Figure 3.13: Question window how many standard sets are to be uploaded.

A separate window pops up showing the path of the csv files 
containing the standard values saved by the MACSPlex_Standard 
Express Mode (naming of csv files according to appropriate data 
file name). Select csv file of choice and confirm. 
The user directory path has to be used to upload the csv file. When 
trying to upload a csv file from another directory a directory 
mismatch warn window appears (refer to figure 3.17). 
When selecting more than one set of standard values the respective 
number of windows will be opened one after the other.

Figure 3.14: Opened explorer with user directory path to upload csv files.

Finally, the information window about the automatically exported 
results is displayed (refer to figure 3.6).

The modified standard values of the MACSPlex_Sample analysis 
are stated in the statistic on the analysis pages (refer to figures 3.15 
and 3.16) 

 ▲ Note: In the exported results the modification of the standard values is not 
mentioned.

Figure 3.15: MACSPlex_Sample analysis from the MACSPlex Cytokine 12 
Kit with changed standard values.

 

Figure 3.16: Statistic of MACSPlex_Sample analysis with changed 
standard values.

Directory mismatch
When trying to upload a csv file from another directory a directory 
mismatch warn window appears (refer to figure 3.17) and the 
upload of the chosen csv files is canceled (refer to figure 3.18). 
In this case transfer csv files of choice to the user directory (path 
displayed in the “directory mismatch” warn window) and start the 
MACSPlex_Sample analysis again.

Figure 3.17: Directory mismatch warn window when trying to upload csv 
file from another directory than the user directory.
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Cancellation of changed standard values
If the process to change the standard value is canceled (e.g. if trying 
to upload from a different directory than user directory or if trying 
to close the upload window using the X button) a warn window 
is displayed, stating the failure during the upload of the chosen 
csv files. In this case the MACSPlex_Sample analysis is processed 
based on the standard values of the experiment. 
To use the MACSPlex_Sample analysis based on changed standard 
values, the analysis has to be started again.

Figure 3.18: Warn window about the failure during upload of csv files.

4.	 Gating strategy for manual analysis without 
Express Mode

Data files can also be analyzed manually on any flow cytometer 
with a similar setup as MACSQuant® Analyzer 10 and MACSQuant 
X (equipped with blue (488 nm) and red (635 nm) lasers able to 
discriminate FITC, PE, and APC fluorescence. Please note that 
the MACSQuant VYB cannot be used.) using the MACSQuantify™ 
Software. 

Grouped samples can be ungrouped after acquisition and analyzed 
individually if desired.

1.	 Right-click on the file name of the MACSPlex Cytokine 
Standard or Sample data file and select Ungroup to analyze 
manually. Once ungrouped, the samples cannot be analyzed 
by an Express Mode, which requires grouped samples. 
Perform ungrouping also of the unkown sample data files.

2.	 Create an analysis template that can be applied to cytokine 
standard and unknown sample data files. 

3.	 Set up the following gating strategy:	  
Detection of singlet beads: forward scatter (FSC) versus side 
scatter (SSC).

Figure 4.1: Detection of the singlet beads in a forward scatter versus 
side scatter plot.

4.	 Detection of MACSPlex Cytokine Capture Bead population: 
Select P1 and display MACSPlex-FITC (B1) versus 
MACSPlex-PE (B2). 

	 Draw an elliptic region around around each single MACSPlex 
Cytokine Capture Bead population. 
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Figure 4.2: Detection of human MACSPlex Cytokine Capture Bead 
populations in a MACSPlex-FITC (B1) versus MACSPlex-PE (B2) 
dot plot (example given for MACSPlex Cytokine 12 Capture Beads, 
human).  

5.	 Right-click on each region and choose Region Properties… 
to assign cytokine names. Different colors for each cytokine 
can also be choosen. Please refer to the kit data sheet for the 
correct assignments of cytokines to the MACSPlex Cytokine 
Capture Bead populations.  

6.	 For APC median determination display the APC median 
of each MACSPlex Capture Bead population in a separate 
statistic by formatting the Region Functions and the Feature 
Functions in the statistic properties. This can be done by 
clicking on the i button next to the statistic.

Figure 4.3: Statistic format displaying the APC median of each 
MACSPlex Capture Bead population. 

7.	 Further calculation: 
	 Calculate the cytokine standards: If using MACSPlex Cytokine 

Standard serial dilution replicates, average the APC median 
for each concentration level of each cytokine and determine 
the cytokine standard curves (cytokine concentration versus 
APC median). 

	 Calculate the cytokine concentration in the unknown samples 
using the cytokine standard curves.
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5.	 Troubleshooting
The following section offers solutions for problems that might be 
encountered when using the MACSPlex Express Modes for the 
MACSPlex Cytokine Kits.

5.1	 Scanning of barcodes was not successful

If the reagent labels on the vials are damaged or the scanning of the 
barcodes is not successful, the reagents can be manually selected 
using the Reagents window: Choose Edit > Reagents… from the 
menu bar to display the window.

1.	 Check reagent position R1. Select the category MACSPlex 
from the Category drop-down list. 

2.	 Select the used MACSPlex Capture Beads / MACSPlex 
Cytokine Kit from the Reagent drop-down list. 

 ▲ Note: When clicking the i button in the Reagents window on the right hand 
side of the MACSPlex Cytokine reagent entry, an Info window will pop up, 
displaying MACSPlex information shown in figures 5.2 and 5.3.

3.	 Check reagent position R2. Select the category Universal and 
select NoLabel from the Reagent drop-down list. 

4.	 Click Apply to save the changes and close the window. 

 
Figure 5.1: Manual selection of the MACSPlex Capture Beads and 
NoLabel settings (example given for MACSPlex Cytokine 12 Kit, 
human). 

5.	 Check the selected reagents in the Autolabel tab located in 
the Experiment tab. The red exclamation mark indicates 
autolabel activation (refer to figure 2.5).

Figure 5.2: Example of MACSPlex information displayed for the 
MACSPlex Cytokine 12 Capture Beads, human. When clicking 
the i button in the Reagents window, an Info window will pop 
up, displaying MACSPlex information. This information will be 
provided when using the autolabel function.

Figure 5.3: Example of MACSPlex information displayed for the 
MACSPlex IL-5 Capture Beads, human. When clicking the i button 
in the Reagents window, an Info window will popup, displaying 
MACSPlex information. This information will be provided when 
using the autolabel function.

5.2 Manual loading of predefined experiments 

If the predefined experiments could not be uploaded automatically, 
they can be loaded manually. 

1.	 Click the Open button of the toolbar or select File > Open… 
from the menu bar. 

2.	 Choose Experiment and Public. 

3.	 Select the subfolder MQ10 for correct instrument configuration. 

4.	 Select the used kit to upload the predefined experiment. 
 ▲ Note: If the experiment does not match with the configuration an 

information window appears stating that annotations have been reset to 
default values.

5.3	 Data acquisition warning windows

Some warning windows may appear after starting the measurement 
directly before picking the sample. Please wait until MACSPlex_
standard and MACSPlex_Sample is picked to make sure all 
settings are correct.

A warning window appears when selecting the MACSPlex_
Standard Express Mode for grouped samples, stating that the 
creation of Sample IDs has failed.

●	 MACSPlex reagents are not selected. Load the MACSPlex 
reagents by using the 2D code reader or select them manually 
by using the reagents window (including NoLabel).

●	 MACSPlex reagents are not assigned correctly. Check the 
reagents in the Autolabel tab.
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A warning window appears when scanning the MACSPlex 
Custom Cytokine Capture Beads, stating that placement is 
impossible.

●	 Seven MACSPlex Custom Cytokine Capture Beads have 
been already scanned (including NoLabel), there are no 
open positions in the Autolabel tab. When working with the 
MACSPlex Express Modes and the MACSPlex Filter Plate the 
maximum number of seven analytes can be processed. Check 
the reagents in the Autolabel tab.

A warning window appears when selecting the MACSPlex_
Standard Express Mode for grouped samples, stating that there 
is an inhomogeneity in the selected MACSPlex Custom autolabel 
entries.

●	 MACSPlex reagents are not assigned correctly, e.g., MACSPlex 
Custom Cytokine reagents for human and mouse (also 
MACSPlex Mix) have been mixed. Check the reagents in the 
Autolabel tab.

A warning window appears when selecting the MACSPlex_
Standard Express Mode for grouped samples, stating that the 
Express Mode is not compatible with the current selection.

 
●	 No Chill Rack has been selected. 
●	 Sample positions have not been grouped. 

A warning window appears when starting the MACSPlex_
Standard Express Mode, stating a multiple defintion of Sample 
IDs.

●	 Within the grouped positions for the current MACSPlex_
Standard measurement Sample IDs have be selected twice or 
more. Assure that each Sample ID is only selected once within 
the grouped positions.

●	 Delete already measured positions from the experiment before 
starting the measurement again.

A warning window appears when starting the MACSPlex_
Standard Express Mode, stating too many defined Sample IDs.

 
●	 Within the grouped positions for the current MACSPlex_

Standard measurement too many Sample IDs have been 
defined. Please refer to the kit data sheet for the maximum 
number of standard positions for the used kit. Delete the 
redundant positions and assure that each Sample ID is only 
selected once within the grouped positions.

●	 Delete already measured positions from the experiment before 
starting the measurement again.

A warning window appears when starting the MACSPlex_
Sample Express Mode, stating that no MACSPlex information 
is provided.

 
●	 MACSPlex reagents are not selected. Load the MACSPlex 

Reagents by using the 2D code reader or select them manually 
by using the Reagents window (including NoLabel).

●	 MACSPlex reagents are not assigned correctly. Check the 
reagents in the Autolabel tab.

●	 Delete already measured positions from the experiment before 
starting the measurement again.

A warning window appears when starting the MACSPlex_Sample 
Express Mode, stating that no standard data are available.

●	 Perform processing of MACSPlex_Standard positions with the 
MACSPlex Cytokine Standard prior to MACSPlex_Sample  
positions with unknown samples.

●	 The time difference between the MACSPlex_Standard and 
the first MACSPlex_Sample measurement has exceeded two 
hours. Repeat the analysis of the MACSPlex_Standard data 
files of the current experiment manually by right clicking on 
the file name within the Samples tab, selecting View with 
Analysis.MACSPlex_Standard.

●	 Delete already measured positions from the experiment before 
starting the measurement again.
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A warning window appears when starting the MACSPlex_
Standard or MACSPlex_Sample Express Mode, stating that the 
opening of the instrument setting Setup-Default has failed.

●	 Perform a PMT calibration of the instrument. For details, 
please refer to the MACSQuantify™ Software user guide.

5.4	 Data analysis warning windows

An export warning window appears instead of the export 
information window:

 

●	 Export failed as the limit of data path length is reached. 
Relocate data files to a shorter data path.

●	 Export failed due to use of special characters (e.g., “ö”, ”ë”, “œ”, 
“µ”, etc.) in sample ID or description.

Failure of analysis 
For example, the warning window “Error during <name of 
Express Mode> analysis. Please contact MACSQuant® Support.” 
is displayed. Data files have to be analyzed manually. Please refer 
to section 4 “Gating strategy for manual analysis without Express 
Mode”. 

Reasons for the failure may be:
●	 Special characters (e.g., “ö”, ”ë”, “œ”, “µ”, etc.) have been used in 

data file name.

●	 No or very few events have been measured. Please, check the 
liquid level in the wells before starting the measurement.

●	 No MACSPlex reagents have been selected in the Autolabel 
tab (refer to figure 2.5). Check the MACSPlex reagents of the 
MACSPlex kit.

●	 Wrong reagents have been selected in the Autolabel tab.

●	 Within a set of MACSPlex_Standard measurements different 
numbers of standard positions have been used. 

●	 MACSQuantify Software on PC has been set to a wrong 
instrument configuration. Choose Edit > Configuration from 
the menu bar to select the correct configuration of the used 
MACSQuant Instrument.

●	 The Express Mode version of the MACSQuantify Software PC 
version is a different one as of the MACSQuant Instrument. 
Always use the same Express Mode version on PC and 
instrument. 

●	 If “No result !” appears as special marking of cytokine 
concentration result: Calculation of the cytokine concentration 

for the relevant analysis was not possible as the standard APC 
median values do not show a proper increasing behavior. 
Other analysis within the experiment may also not have the 
expected behavior due to premixed cytokine standards. Please 
check all other results.

●	 MACSPlex_Sample Analysis of older data files (with not all 
analytes assigned) is performed with the current MACSPlex 
Express Modes using the standard values of the experiment 
(likewise with not all analytes assigned). Repeat the 
MACSPlex_Sample analysis and use changed standard values 
(refer to chapter 3.3) to make sure that identically identified 
analytes are used for standard and sample analysis.

Refer to www.miltenyibiotec.com for all data sheets and protocols. 
Miltenyi Biotec provides technical support worldwide. Visit  
www.miltenyibiotec.com for local Miltenyi Biotec Technical 
Support contact information.
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Legal notices
Limited product warranty
Miltenyi Biotec B.V. & Co. KG and/or its affiliate(s) warrant this product to be free 
from material defects in workmanship and materials and to conform substantially 
with Miltenyi Biotec’s published specifications for the product at the time of order, 
under normal use and conditions in accordance with its applicable documentation, 
for a period beginning on the date of delivery of the product by Miltenyi Biotec or its 
authorized distributor and ending on the expiration date of the product’s applicable 
shelf life stated on the product label, packaging or documentation (as applicable) or, 
in the absence thereof, ONE (1) YEAR from date of delivery (“Product Warranty”). 
Miltenyi Biotec’s Product Warranty is provided subject to the warranty terms as set 
forth in Miltenyi Biotec’s General Terms and Conditions for the Sale of Products 
and Services available on Miltenyi Biotec’s website at www.miltenyibiotec.com, as 
in effect at the time of order (“Product Warranty”). Additional terms may apply. BY 
USE OF THIS PRODUCT, THE CUSTOMER AGREES TO BE BOUND BY THESE 
TERMS.
THE CUSTOMER IS SOLELY RESPONSIBLE FOR DETERMINING IF A 
PRODUCT IS SUITABLE FOR CUSTOMER’S PARTICULAR PURPOSE AND 
APPLICATION METHODS.

Technical information
The technical information, data, protocols, and other statements provided by 
Miltenyi Biotec in this document are based on information, tests, or experience 
which Miltenyi Biotec believes to be reliable, but the accuracy or completeness of such 
information is not guaranteed. Such technical information and data are intended for 
persons with knowledge and technical skills sufficient to assess and apply their own 
informed judgment to the information. Miltenyi Biotec shall not be liable for any 
technical or editorial errors or omissions contained herein. 
All information and specifications are subject to change without prior notice. Please 
contact Miltenyi Biotec Technical Support or visit www.miltenyibiotec.com for the 
most up-to-date information on Miltenyi Biotec products.

Licenses
This product and/or its use may be covered by one or more pending or issued patents 
and/or may have certain limitations. Certain uses may be excluded by separate terms 
and conditions. Please contact your local Miltenyi Biotec representative or visit 
Miltenyi Biotec’s website at www.miltenyibiotec.com for more information.
The purchase of this product conveys to the customer the non-transferable right to 
use the purchased amount of the product in research conducted by the customer 
(whether the customer is an academic or for-profit entity). This product may not be 
further sold. Additional terms and conditions (including the terms of a Limited Use 
Label License) may apply.
CUSTOMER’S USE OF THIS PRODUCT MAY REQUIRE ADDITIONAL 
LICENSES DEPENDING ON THE SPECIFIC APPLICATION. THE CUSTOMER 
IS SOLELY RESPONSIBLE FOR DETERMINING FOR ITSELF WHETHER IT HAS 
ALL APPROPRIATE LICENSES IN PLACE. Miltenyi Biotec provides no warranty 
that customer’s use of this product does not and will not infringe intellectual property 
rights owned by a third party. BY USE OF THIS PRODUCT, THE CUSTOMER 
AGREES TO BE BOUND BY THESE TERMS.

Trademarks
MACS, the Miltenyi Biotec logo, MACSQuant, and MACSQuantify are registered 
trademarks or trademarks of Miltenyi Biotec and/or its affiliates in various countries 
worldwide. 

Copyright © 2022 Miltenyi Biotec and/or its affiliates. All rights reserved.


